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Installing a network site license
If you are upgrading your License Server from Sibelius 1.4, Sibelius 2 or Sibelius 3, see
Upgrading the License Server below.

Types of site license
Two types of Sibelius site license are available: stand-alone site licenses and network site
licenses. You have purchased a network site license for a particular number of copies.

Overview
Sibelius’ network version operates on a client-server model. The Sibelius program itself is
installed on the local hard drive of each of the client workstations, and a separate License
Server program is installed on a single designated server or workstation. It may also be
managed from another workstation.

The License Server program is supplied on a separate CD-ROM from the Sibelius program
itself and enables the designated number of licensed client copies to run on the network
simultaneously. The License Server also lets you send messages to users of the client copies,
and close copies down from the server machine.

Requirements
The Sibelius License Server will run on Windows 2000 Professional, Windows XP, Win-
dows 2000/2003 Server, Mac OS X 10.2.8 or later, Mac OS X Server 10.2.8 or later, or on an
Apple Xserve.

Sibelius requires a network using the TCP/IP protocol. (Your network may use other proto-
cols in addition to TCP/IP, but TCP/IP must be present in order for the License Server to
communicate with the client copies.)

If you use a firewall on your network, ensure that port 7312 is open both for TCP/IP and
UDP traffic.

If you use a Novell network, note that you cannot install the Sibelius License Server onto a
server running Novell Netware. The License Server can only be run on Windows or Mac OS
servers or workstations. To run Sibelius on a Novell network, you will need to install the
License Server program on a suitable Windows or Mac OS workstation.

Installing the License Server
Copy the executable file LicenseServerV4 from the supplied CD-ROM into a suitable
folder on a single machine (ideally your server, although you can use a workstation if pre-
ferred, provided it is running one of the supported operating systems).
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You must copy the License Server program to your computer: it cannot be run successfully
from CD-ROM.

* If you are using Windows, we recommend that you sign on as Administrator and create a
folder in the root of C:, the local hard disk, and copy the executable file into there.  The
folder should have full read/write access to Administrators.  Note, as you have to navigate
to this folder from a command prompt window, it would be advisable to restrict the
name to 8 characters or fewer. If you are using Windows, make sure you have adminis-
trative rights (e.g. you are logged in as Administrator on your server) before copying the
file onto your computer.

* If you are using Mac OS X, you should log on as Administrator or to an account with
Administrator privileges, then copy the executable to a suitable location, such as /usr/
local/bin. Note that the bin folder may not exist so may need to be created. /usr/local is
a hidden folder and you will need to navigate there from a Go command in the Finder.
(The suggested folder is in line with Unix conventions although in practice any folder
may be used, provided you and the Administrators user group have unrestricted access.
It is not considered good practice to allow free access from all groups to a Unix folder.)

Configuring and using the License Server
Now see Configuring the License Server on page 11.

Installing Sibelius
Before you install Sibelius, you should liaise with your music staff or network administra-
tors about the best place to install Sibelius’s example scores.

* On Windows, Sibelius installs the example scores into a folder called Example Scores
inside the Sibelius 4 program folder, and creates a shortcut to this folder inside the My
Documents folder belonging to the current user. If you want to make these files avail-
able to all users, you should manually copy the Example Scores folder to an appropriate
location on the network.

* On Mac, you should copy the Example Scores folder from the Sibelius 4 CD-ROM to an
appropriate location on the network, if you want to make these files available to all
users.

Install Sibelius on each of your client machines following the instructions in your Hand-
book, using the same serial number (starting SCEW, SWEW, or SCEG) that you used to reg-
ister the License Server (you don’t need to register the client copies).

It is essential that Sibelius be installed on the local hard disk of each client machine. It can-
not be installed on a network drive or a virtual disk.
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You can install Sibelius on all the client computers using the same serial number; as long as
all your computers are connected on the same network via TCP/IP and can thus see the
machine running the License Server, they can share the same license.

You can install Sibelius on as many computers as you like, but it will only allow as many
copies as are licensed to be run simultaneously; you could install Sibelius on 30 computers,
but if you only have a license for 10 copies, only 10 copies will be able to run simultaneously.

Note that, regardless of how many copies you have bought, you will only receive one instal-
lation CD-ROM and serial number, valid for the appropriate number of licenses purchased.

When you run each client copy of Sibelius for the first time, you will be prompted for the
location of the machine running the License Server. You should supply this information as
an IP address (e.g. 192.168.1.100:port) or you can specify the server name (e.g. server).

You can also enter the port on which the License Server is running (although there is no
need to do this unless you have explicitly changed it when setting up the License Server –
see Configuring the License Server on page 11).

This information is stored on the client computer and does not need to be entered again.

Sibelius will then contact the server in order to get permission to run. If the maximum
number of licensed copies has not been exceeded, it will start up and run normally. If the
maximum number of copies has been reached, a message will inform you of this and Sibe-
lius will quit.

As the networked copies of Sibelius run, they remain in contact with the server, which
maintains a list of copies running. Should a client machine crash or become disconnected
for some reason, the License Server will remove that copy from the list. If a copy of Sibelius
cannot contact the License Server, it will quit, allowing the user to save their work first.

Note about subnet masks
A subnet mask is used on a TCP/IP network to determine which IP addresses belong to the
individual network, or subnet. For example, a typical network uses IP addresses in the
range 192.168.1.n (where n is an integer from 0-255); in this case, the subnet mask would
be 255.255.255.0, signifying that only the last digit of the IP address of each client machine
on the network may be variable. The final digit of the subnet mask address varies according
to the precise range of the subnet: a value of 0 allows the full range of 0-255 to be used in
the IP addresses of the client machines.

In some cases, particularly where a network uses dynamically-assigned IP addressing (via
DHCP), the subnet mask on the machine running the Sibelius License Server may not be
correctly configured to allow access by all client machines on the network.
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This symptoms of this problem are as follows:

* Sibelius cannot find the License Server on the network, but;
* it is possible to ping the server machine from the client machine and vice versa.

If you experience the above problem, review the subnet mask settings on both machines. If
your network uses a router to control access from one subnet to another, the router will
take precedence over the subnet mask setting.

Security
To maintain proper security on your network, the Sibelius and License Server CD-ROMs
should only be used by the network administrator. Store them and this booklet in a secure
place after use so that students cannot access them. Do not copy the CD-ROMs – copying is
illegal.
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Upgrading a network site license
To upgrade your network site license from Sibelius 1.4, Sibelius 2 or Sibelius 3 to Sibelius 4,
you will need to upgrade both the License Server and all the client machines.

Upgrading the License Server
* Quit the License Server on the computer on which it is installed
* If you have the License Server installed as a Windows NT/2000/XP service, uninstall it by

going to the License Server console and typing uninstall

* Delete the folder containing the License Server to avoid confusion with the later version
* Install, register, configure and run the LicenceServerV4 executable according to the

instructions in this booklet.

Upgrading the client machines
To upgrade each of the client machines, use the Sibelius 4 CD-ROM (not the License Server
CD-ROM) and follow the instructions described in the Upgrading to Sibelius 4 booklet.
There are two important differences from the instructions in the booklet:

* You will not be prompted to enter an Upgrade Code
* On Windows, the installer will detect that each client copy is unregistered. This is nor-

mal, as network copies of Sibelius are only registered when authorized by the License
Server. Ensure you switch on the Upgrade unregistered copy option when the installer
reports that the detected copy is unregistered.

Note that the Sibelius 4 splash screen will say UNREGISTERED COPY as the program is
loading (because at that point it has not yet been registered by the License Server over the
network), but if you check Help > About Sibelius (in the Sibelius menu on Mac) after
running the program, it will display Network Copy, which shows that it has been cor-
rectly registered by the License Server.
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Running two License Servers
The Sibelius 4 License Server and the revised Sibelius 3 License Server may be run simulta-
neously on the same server and installed concurrently as Windows 2000/2003/XP services
or Mac daemons. If you need to do this, it will be necessary to change the port number
used by one of the license servers by using the port command in configure mode. When
signing on a client copy for the first time to a license server with a different port number,
the syntax for the server IP address will be, for example,192.168.1.183:nnnn (where nnnn
is the new port number).

If you do not have the most up-to-date Sibelius 3 License Server, visit

http://www.sibelius.com/helpcenter/upgrades.html#network

to download the latest version.

http://www.sibelius.com/helpcenter/upgrades.html#network


Using the License Server

11

Using the License Server

Installing the License Server
See Installing the License Server on page 5.

Configuring the License Server
The License Server is a simple Unix program operated from a command window on a
Windows machine and a terminal window on a Mac.  It operates in three modes and may be
installed as a Windows service or a Mac daemon. The three modes are:

* Configure mode: used initially to set serial number, registration, port number and access
control

* Run mode: runs the server message loop. This is non-interactive and may run as a ser-
vice (Windows) or a daemon (Mac OS X).

* Management mode: communicate with a running server (which may be on another
machine) to test it, query clients, warn or kick clients, or install as a service or daemon.

Before the License Server can be used, you must register it from configure mode and set up
access controls.

Starting and configuring the License Server on Windows
* In Windows, open a command prompt by choosing Start > Run, typing cmd in the dialog

and clicking OK.
* Navigate to the folder containing the License Server using the cd (change directory)

command and start it by typing:
LicenceServerV4 –v –configure

then hit Return. (Hereafter, hit Return after each line of commands that you see.)
Type cd \ to return to the root directory of the hard disk before using cd to the folder
where the License Server has been copied. (See the list of Useful Windows/DOS com-
mands on page 23 for more details.)

* Enter your serial number by typing serial followed by your full serial number, then hit
Return, e.g.

serial SCEW 300 200 100 123456

Network licence serial numbers start with SCEG, SWEW or SCEW.  (If you are upgrading
from a previous version, your original serial number will be accepted by the Sibelius 4
License Server.)
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* The response, provided the serial number is accepted will be to display a request to regis-
ter and quotes a computer number starting with C.  At this point, it is necessary to con-
tact Sibelius Registration to register the License Server.  Please ensure that you know how
many copies you have bought licences for before contacting Sibelius Registration.  Once
you have the Registration number, enter it by typing reg followed by the Registration
Number, which starts with the letter R and is followed by 16 digits, then hit Return, e.g.:

reg R 1234 5678 8765 4321

* Assuming the registration number is accepted, the next thing you need to do is to set up
the access controls so type

access

* The local manager, 127.0.0.1, is installed by default both as a manager and as a client.
Access mode commands are:
% ac to add a client or clients;
% am to add a manager;
% bc to block a client; and
% bm to block a manager.
The wild card * (asterisk) may be used when adding clients, for example, ac 192.168.1.*
will allow all clients in the subnet 192.168.1.x to access the License Server. Review your
access settings and, if satisfied, type q followed by Return to exit access mode.  (Access
commands are listed in the quick reference section at the end of this booklet.)

* Type q and hit Return to exit “configure mode.”
* In a separate command window, set the License Server to “run mode” by typing

LicenceServerV4 –vv 

(Note that the –v or –vv parameters cause the program to generate more verbose mes-
sages, which may be useful while setting up the server.)

* In the original command window, type
LicenceServerV4 –v –test

and observe the messages to be as follows:
Trying:  Sending Slave alive message
Success:  got authorization reply
Trying: Sending save request message
Success:  got authorization reply
Trying:  Sending quit message
success:  client quit, shutdown message received

* Other management commands such as query, warn, kick and port may be entered using
the same syntax. For example, type

LicenceServerV4 –v –query
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to which a reply of:
Attempting to query server:127.0.0.1 port: 7312
Success: No Clients on Server

may be expected as no clients have been started as yet.
* At this point, providing the test command functions correctly, it is worth trying to install

and start a client copy. Run Sibelius on a client machine and a dialog will open, request-
ing the IP address or name of the Server.  Enter the IP address or server name and click
OK.  Unless you have specifically changed the port number the default (7312) will be
used.  Again, observe the messages.  If all is well, install the License Server as a Windows
service by typing:

LicenceServerV4 –v –install 

in the first command prompt window.
* A message will appear to say that the service has been installed successfully.  Check Win-

dows Services to see that the Sibelius License Server V4 is installed and that the status is
Started and Automatic.
If the status is not Started and an attempt to start it gives an error message (Error 0005
Access denied), there may be an access restriction on the folder or drive in which the
License Server is installed.

Starting and configuring the License Server on Mac
For users of Unix-based operating systems, much of what follows will be familiar, but many
users of Mac OS X may not have experience of Unix-based commands, and so this may
seem like a strange and complicated voodoo! Experienced users should smile knowingly
and be patient while inexperienced users are initiated.

* Open a Terminal window (run /Applications/Utilities/Terminal) and switch to root by
typing

sudo bash –login

then hit Return. (Hereafter, hit Return after each line of commands that you see.)
* You will be asked for the root password, so enter it and hit Return.
* Now navigate to the folder where you have copied the License Server; for argument’s

sake, let’s say it was /usr/local/bin – so type
cd /usr/local/bin

* Start the License Server in configure mode by typing
./LicenceServerV4 –v –configure

Note that Unix filenames are case-sensitive.
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* Enter your serial number by typing serial followed by your full serial number, then hit
Return, e.g.

serial SCEW 300 200 100 123456

* Network licence serial numbers start with SCEG, SWEW or SCEW.  (If you are upgrading
from a previous version, your original serial number will be accepted by the Sibelius 4
License Server.)

* The response, provided the serial number is accepted will be to display a request to regis-
ter and quotes a computer number starting with C.  At this point, it is necessary to con-
tact Sibelius registration to register the License Server.  Please ensure that you know
how many copies you have bought licences for before contacting Sibelius Registration.
Once you have the Registration number, enter it by typing reg followed by the Registra-
tion Number, which starts with the letter R and is followed by 16 digits, then hit Return,
e.g.:

reg R 1234 5678 8765 4321

* Assuming the registration number is accepted, the next thing you need to do is to set up
the access controls so type

access

* The local manager, 127.0.0.1, is installed by default both as a manager and as a client.
Access mode commands are:
% ac to add a client or clients;
% am to add a manager;
% bc to block a client; and
% bm to block a manager.
The wild card * (asterisk) may be used when adding clients, for example, ac 192.168.1.*
will allow all clients in the subnet 192.168.1.x to access the License Server. Review your
access settings and, if satisfied, type q followed by Return to exit access mode.  (Access
commands are listed in the quick reference section at the end of this booklet.)

* Type q and hit Return to exit “configure mode.”
* In a new Terminal window (choose File > New in Terminal), set a new instance of the

License Server to run mode by using cd to change to the directory in which the License
Server is located, then typing:

./LicenceServerV4 –vv

Note that the –v or –vv parameters cause the program to generate more verbose mes-
sages, which may be useful while setting up the server.

* In the original Terminal window, type
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./LicenceServerV4 –v –test

and observe the messages to be as follows:
Trying:  Sending Slave alive message
Success:  got authorization reply
Trying: Sending save request message
Success:  got authorization reply
Trying:  Sending quit message
success:  client quit, shutdown message received

* Other management commands such as query, warn, kick and port may be entered using
the same syntax; for example, type

./LicenceServerV4 –v –query

to which a reply of
Attempting to query server:127.0.0.1 port: 7312
Success: No Clients on Server

may be expected as no clients have been started as yet.

At this point, providing the test command functions correctly, it is worth trying to install
and start a client copy. Run Sibelius on a client machine and a dialog will open, requesting
the IP address or name of the Server.  Enter the IP address or server name and click OK.
Unless you have specifically changed the port number the default (7312) will be used.
Again, observe the messages.

If all is well, now is the time to install the License Server as a daemon. Scripts to start, stop
and reload the License Server are provided. It will be necessary to edit the scripts to suit
your installation before they can be used – see Running the License Server as a Mac
daemon below.

Remote management
Remote management of the License Server requires that an unregistered copy of the
License Server be installed on the computer from which the registered License Server is to
be managed. You must use the same Sibelius serial number for both License Servers.

The IP address of the remote workstation from which management is required must be
entered in the access control settings of the registered License Server (see above).

The remote License Server should not be registered, neither should it have any access con-
trol settings.

The following commands can be used from the remote License Server: 

query <server IP:[port]> List clients currently connected to the server
kick all <server IP:[port]> Closes all clients connected to the server
kick <client IP> <server IP:[port]> Closes the specified client
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warn “message” all <server IP:[port]> Sends a message to all clients
warn “message” <client IP> <server IP> Sends a message to the specified client

To use a command, you type directly into a command window (Windows) or Terminal
window (Mac), e.g. on Windows:

LicenceServerV4 -v -query 192.168.9.10

and on Mac:

./LicenceServerV4 -v -warn “Get back to work!” 192.168.9.10

Unexpected exits
In the unlikely event that a copy of Sibelius running on a client machine exits unexpectedly
(e.g. if it crashes), the License Server will not allow Sibelius to be started again on that par-
ticular machine for three minutes thereafter. Attempting to run a copy of Sibelius on that
client within that time will display the error message Sibelius cannot run because the
server already has a copy registered on this address. If the user waits for three min-
utes, they will be able to successfully restart Sibelius.

Running the License Server as a Windows 2000/2003/XP service
If you wish to run the License Server as a Windows service, type:

LicenseServerV4 -v -install

and hit Return, from a command prompt pointing at the appropriate folder. To uninstall
the service, type LicenseServerV4 -v -uninstall from the same location.

To check that the License Server is correctly installed as a service, go to Start > Settings >

Control Panel > Administrative Tools > Services (in Windows 2000/XP). Sibelius License
Server should appear in the list, and its Startup Type should read Automatic. You can run
the license server in test or query mode as described above, to verify the correct operation
of the service.

Otherwise, set the License Server to run every time your server is started in a way appro-
priate to your system. For testing purposes you may want just to run it in a console win-
dow.

If the License Server service won’t start and you get an Error 0005 Access denied mes-
sage when you try to start the service, you should check the permissions of the folder where
the License Server is located. The License Server must have write access to the folder in
which it is installed.
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Running the License Server as a Mac daemon
Annotated, editable scripts are provided that can be used to start, stop and reload the
License Server. Listings of the script contents are included in an appendix below.

Copy these scripts to a sensible location, e.g. into the same folder as the License Server
program itself. Edit the scripts so that they refer to the folders used in your installation.
Note that it may be necessary to be logged on as root in order to run the scripts.

* To install as a daemon, just type ./start_licence_server

* To uninstall, type ./stop_licence_server

* To reload the License Server, necessary if you have made changes to the access controls,
type ./reload_licence_server

You may list the running processes by typing ps -a or ps -ax; ps-ax will list all processes
including hidden ones. The License Server may still be configured, tested and queried at
any time by typing the appropriate commands in a terminal window.

After you have installed the License Server as a daemon, log out of your Terminal window
by typing Control-D or simply logout. You may then quit Terminal, leaving the daemon
running.

To get the License Servers to start automatically when the server starts up, log in as root
and add an entry to /etc/rc.local giving the full path and name of the script that starts the
License Server; the line in /etc/rc.local might look like this:

/usr/local/bin/start_licence_server

It is possible that the file rc.local does not exist, so you may need to create it.

Log out when you have finished and reboot the server at a convenient time to check that
the License Server is running, by opening a terminal window and typing ps -a.
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Changing the port used by the License Server
The default port used is 7312. There is normally no need to change this, and we recom-
mend that you leave this setting at its default.

To change port, open a command window (Windows) or Terminal window (Mac), navigate
to the folder in which the License Server is located and type:

LicenceServerV4 -v -configure

followed by Return. Then at the prompt type:

port 1234

where 1234 is the desired port number, then type q followed by Return to exit configure
mode. The server will henceforth run on that port each time it is started until a different
port is specified.
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Troubleshooting

Error message “unable to bind sockets” (Windows XP)
If you get the error message “unable to bind sockets,” check your firewall settings (in Con-
trol Panel > Network Connections).

Error 0005 Access Denied
If you get an error message (Error 0005 Access denied), there may be an access restric-
tion on the folder or drive in which the License Server is installed.

Licence server won’t accept registration number
* Have you copied the License Server executable to your hard disk?
* Do you have full read/write access to the folder where the License Server is located?

License Server is apparently installed correctly but the clients cannot 
“see” the License Server

* Open a command window (Windows) or Terminal window (Mac) and use ping to con-
tact the server from the client and vice versa to establish basic connectivity. If ping is
successful in both directions, network traffic is able to be routed between the two
machines. If ping fails, it’s possible that another device on the network (e.g. a program-
mable switch) is blocking the traffic between the License Server and the client.

* Review your access settings. Open a command or Terminal window and start the
License Server in configure mode to display current settings. If necessary, enter access
mode and modify the settings. The d command is useful in deleting all previous entries
so that you can start afresh. The output from starting the License Server in configure
mode would, typically, look like this:

Serial Number:    SCEWnnn nnn nnn nnnnnn
Site Code:        C nnnn nnnn nnnn nnnn
Number of copies: 2
Port: 7311

Clients Allowed: 127.0.0.1, 192.168.1.*
Managers Allowed: 127.0.0.1
Clients Blocked:
Managers Blocked:
------------------------------------------
serial <serial>       Set the serial number to <serial>
reg    <regnum>       Set the registration number to <regnum>
port   <portnum>      Set the port number to <portnum>
access                Change access control settings
q                     Exit configure mode
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* Messages to/from the License Server may be observed in run mode.  In a command or
Terminal window type

LicenceServerV4 –vv

This is extremely useful in observing messages such as “wrong version,” “client
ignored,” the result of the wrong version of Sibelius or an out of range client trying to
access the License Server.  A typical output might be as follows:

Serial Number:    SCEW nnn nnn nnn nnnnnn
Site Code:        C nnnn nnnn nnnn nnnn
Number of copies: 2
Port: 7311
Clients Allowed: 127.0.0.1, 192.168.1.*
Managers Allowed: 127.0.0.1
Clients Blocked:
Managers Blocked:
------------------------------------------
(15230)192.168.1.167(4703):Slave alive
(15230)192.168.1.167(4703):New client at address
(15230)192.168.1.167(4703):Adding client 1 (max 2)
(0)192.168.1.167(4703):poll count (15230)192.168.1.167(4703):poll-
ing client (65535)192.168.1.167(4703):poll count
(15244)192.168.1.167(4703):polling client
(15245)192.168.1.167(4703):Poll response from client
(15245)192.168.1.167(4703):Poll response from client
(0)192.168.1.167(4703):poll count
(15254)192.168.1.167(4703):polling client
(15255)192.168.1.167(4703):Poll response from client

* The management commands -test, -query, -warn and -kick are also useful in checking
an installation.

Error message “Could not bind the IP socket to the correct port”
If you see the error message Could not bind the IP socket to the correct port when run-
ning the License Server, you may be running another application on this port already. Try
using the port command to change the port number. (This may occur if you are running
both the Sibelius 2 and Sibelius 3 License Servers on the same server.)

Client copies of Sibelius on Mac lose contact with the License Server
Make sure that your server is not allowed to go to “sleep” as this will stop the License Server
from responding. You should also ensure that your server does not install software updates
automatically, as this will also stop the License Server from responding.
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License Server receives messages but client doesn’t “see” License 
Server

This can be caused by the firewall settings in Windows XP Service Pack 2. Turn the firewall
off to check this and, if this works, add an appropriate exception to the firewall rules. A clue
to this problem is found when viewing the messages: you will see slave alive followed by
an extra slave alive message.
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Quick reference

License Server commands
The following commands can be used from the License Server console (type space to
access the console):

Useful Unix commands
* chmod – used to change the attributes of a file
* ls –al – lists all the files in a directory with their attributes
* ps –ax – lists all running processes including hidden ones.

Set-up commands (accessible only from the local machine):

serial serial Set the serial number to serial (no space

reg regnum Set the registration number to regnum (no spaces)

port portnum Set the port number to portnum

access Enter access mode from configure mode

q Quit access mode

q Quit configure mode

Management commands (can be run from a remote server if you have management access control set up)

-install Installs as a Windows 2000/2003/XP service

-uninstall Uninstalls Windows 2000/2003/XP service

-query machine Get information on server on machine (IP address)

-kick [all] Close (all) clients

-kick address Close all clients on IP address address

-kick address:port Close client with this IP address/port number

-kick address server Close clients on this server

warn “message“ address[:port] Warn clients on this address/port

warn “message“ Display this warning message on all clients

Access mode commands (after typing access at the console)

am address / ac address Allow management/client access

rm address / rc address Revoke management/client access

bm address / bc address Block management/client access
N.B. If you block management access from a client and later wish to re-instate
access, you will have to use d to delete all entries in the access list, and then re-add
them all.

d Delete access lists

q Quit access mode
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* mkdir –m 775 name makes a directory called name with full read/write access for the
owner and their group (typically the admin group), but prevents write access for other
users.

* ./filename will run an executable or script called filename in the current directory, pro-
vided you are using bash or a bash-compatible shell (as suggested earlier). Once unique
characters have been typed, the Tab key will auto-complete the rest of the file name for
you.

Useful Windows/DOS commands
* cd – change directory (the old name for folder).
* cd .. – moves to the next higher directory. If you repeat this enough times, you will get

back to the root of the hard disk.
* cd directoryname – takes you to the directory called directoryname. If you copied the

License Server program to a folder named LSV4 (for example) then cd LSV4 will get you
there.

* dir – lists the contents of a directory.  Use this to check that you are in the right directory.
* exit – closes a command prompt window.

Mac scripts to start, stop and reload the License Server
The License Server CD includes three useful annotated scripts for Mac users which may be ed-
ited to suit a specific installation and then used to start/stop and reload the License Server pro-
gram.  These are as follows:

start_licence_server

#!/bin/sh

PROCID=`ps -a | grep LicenceServerV4 | grep -v grep | awk '{print 
$1}'`

if [ "$PROCID" ]; then 

echo "Already running - process $PROCID "

else

# Start the licence server and redirect the output to a log file
# Run in daemon mode (-D) so that we ignore the hangup signal

/var/root/bin/LicenceServerV4 -v -D >> /var/log/LicenceServer.log &

# To verify that this is running correctly, you can run:
# /var/root/bin/LicenceServerV4 -v -test

fi
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stop_licence_server

#!/bin/sh

# grep the process list for the instance of the licence server and
# extract the process ID (the first argument)

PROCID=`ps -a | grep LicenceServerV4 | grep -v grep | awk '{print 
$1}'`

if [ "$PROCID" ]; then

echo "Sending stop signal to LicenceServerV4 - proc $PROCID"

kill $PROCID

else

echo "No LicenceServer running"

fi

reload_licence_server

#!/bin/sh

# grep the process list for the instance of the licence server and
# extract the process ID (the first argument)

PROCID=`ps -a | grep LicenceServerV4 | grep -v grep | awk '{print 
$1}'`

echo "Reloading the LicenceServer by sending the HUP signal to pro-
cess $PROCID"

kill -HUP $PROCID
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